
TEXT EDITOR
Mnemonic added on View ("V") and Document ("D") in

the menu bar

Refactoring of some large part of the source code

Thanks to right button click, a popup menu displays

the following features:

◗ Execute in Scilab
◗ Edit selection into a new text editor
◗ Copy
◗ Select all
◗ History
◗ Help on the selected text

See Bug # 5387

Bug Fixes:

◗ Bug # 4873 fixed - "undo" did not work if the last action
affected several lines
◗ Bug # 4883 fixed - "Menu->Document->Auto Indent"
preference was not saved
◗ Bug # 4886 fixed - Performance enhancements for
colorization (notable speed-up on opening large scripts)
◗ Bug # 5013 fixed - Find/Replace dialog box: Buttons
were resized after the search
◗ Bug # 5103 fixed - File=>Save now opens the "Save"
dialog box for Untitled files even if they are not modified
◗ Bug # 5125 fixed - An infinite loop is no more got when
using the Undo functionnality
◗ Bug # 5137 fixed - Drag & drop on editor was not
enabled
◗ Bug # 5140 fixed - "Load into Scilab" was executed line
by line
◗ Bug # 5171 fixed - Problem with the highlight in the
undo manager 
◗ Bug # 5173 fixed - Better multi-thread correctness wrt
Event Dispatching Thread
◗ Bug # 5174 fixed - The undo did not work on tab
◗ Bug # 5189 fixed - No more error when a file selection
for saving is cancelled
◗ Bug # 5219 fixed - Rename of the item menu "Indent"
=> "Reformat Selection"
◗ Bug # 5220 fixed - In editor, "Colorize" action in
"Document" menu is now implemented as check box
◗ Bug # 5224 fixed - Maj+Tab modified the text selection
◗ Bug # 5270 fixed - In editor, shortcut for the line
numbering (CTRL+L) changed and assigned to "Load into
Scilab" in order to match the old behavior
◗ Bug # 5290 fixed - Function editorHighlightLine
removed, and editor updated in order to have in argument
files to open and lines to be highlighted for each files
◗ Bug # 5308 fixed - Editor did not check input argument
type
◗ Bug # 5317 fixed - Inserting a tab inside a line tabified
the whole line instead of only its queue
◗ Bug # 5318 fixed - When a "if" line took its "end" on the
line, its indentation was one level too high 

◗ Bug # 5319 fixed - Default filename proposed in 'Save
As' dialog
◗ Bug # 5341 fixed - "Save All" functionality was missing
◗ Bug # 5386 fixed - Wrong title for auto indent action in
menu
◗ Bug # 5460 fixed - 'Close All' and 'Close all but this'
added menus in editor
◗ Bug # 5465 fixed - Better Undo/Redo support (works
across "Save"/ "Save as..", undo / redo multiple edits on a
region in one go)
◗ Bug # 5482 fixed - It was not possible to choose EOL
type
◗ Bug # 5497 fixed - Selection drag was not available
◗ Bug # 5515 fixed - Encoding was not well managed
Now:
- default encoding is the system default one
- user defined encoding save in Editor configuration file
◗ Bug # 5519 fixed - Message asking the user if he wants
to exit the editor when he clicks on the cross added

HELP BROWSER
Thanks to right button click, a popup menu displays

the following features:

◗ Execute in Scilab
◗ Edit in the text editor
◗ Copy
◗ Select all
◗ History
◗ Help on the selected text

In the console and the text editor, in the menu

associated to the right button click, the item "Help on

the selected text" has been added.

TEXT RENDERING
New function "prettyprint" added

This function provides the capability to represent a Scilab
variable to LaTeX, TeX and Mathml. 
See SEP # 36 for more information

pol2tex is now obsolete

Please use prettyprint instead

texprint is now obsolete

Please use prettyprint instead

Bug Fixes:

◗ Bug # 5303 fixed - pol2tex() could not be used
straightforwardly with the new "$...$" LaTeX feature.
◗ Bug # 5304 fixed - texprint() could not be used with the
new "$...$" LaTeX feature.
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ATOMS
An "offline" mode has been added

This mode allows the user to install modules from a local
repository or a local package even if the network is
unreachable: 
--> atomsSetConfig('offLine','True');
--> atomsInstall("/home/johnsmith/module_lycee_1.1.bin.i686.
linux.tar.gz");

GRAPHIC EXPORT
Refactoring of the graphic export for vectorial files

(PDF, EPS, PS & SVG) through FOP/Batik:

◗ Improved quality of the vectorial export
◗ Improved size of the PDF (PS & EPS are however
bigger but this should be fixed in Scilab > 5.2.0)
◗ Handles export of graphics with LaTeX/MathML text
◗ Bug # 4200 fixed - Export PDF was causing a "bad
/BBox" with Acrobat

LOCALIZATION
Some strings were untranslatable/untranslated

See Bug # 4124

Some typos fixed

DOCUMENTATION IMPROVEMENTS
More examples with LaTeX use-cases (colors, etc)

COMPILATION
Rebuild some C++/Java wrappers with a newest

version of SWIG

In some cases under Windows, the detection of

libjogl.* could fail because of a missing explicit link

against libGL.*

XCOS
Icon added in the main Scilab tool bar

Bug Fixes:

◗ Bug # 4997 fixed - Now Scilab editor and Xcos ask to
save unsaved documents when user closes Scilab
◗ Bug # 5026 fixed - Now palette browser appears only
with a new diagram or by the menu View->Palette browser
◗ Bug # 5052 fixed - The context variables defined at an
upper level were not known at a lower one
◗ Bug # 5053 fixed - Layout of in/out port of a block when
modified, updated
◗ Bug # 5054 fixed - Remove ports on a block remove the
connected links
◗ Bug # 5083 fixed - If lines are selected and user call the
"Find/replace" dialog box, the radiobox "Selected lines" in
the frame "Scope" is checked by default
◗ Bug # 5099 fixed - Diagram was not visible after a "Fit
diagram to view"

◗ Bug # 5104 fixed - The block view was not updated on
undo/redo
◗ Bug # 5111 fixed - "Save As" default path was not the
current file path
◗ Bug # 5158 fixed - Region to SuperBlock now keeps
links breaks inside and outside SuperBlock
◗ Bug # 5159 fixed - The region to superblock action could
not be undone/redone
◗ Bug # 5167 fixed - xcos*.h5 and xcos*.h5 were not
deleted
◗ Bug # 5179 fixed - The accented letters used in text in
Scicos diagram were not visible with Xcos at least under
Linux
◗ Bug # 5180 fixed - TEXT_f was not selectable on the
palette
◗ Bug # 5182 fixed - In some cases, the main diagram
dialog no more responded neither to the "validate" nor
"cancel" menu
◗ Bug # 5183 fixed - Simulation menu was not disabled on
a superblock diagram
◗ Bug # 5184 fixed - Setup menu values were not
localized
◗ Bug # 5188 fixed - A function to reopen a parent
diagram was added in the pop up menu of the diagram
◗ Bug # 5196 fixed - Opening a SuperBlock modified
some positions
◗ Bug # 5202 fixed - The description of a module is now
scrollable
◗ Bug # 5209 fixed - Bad French translation for
"Optimisation and Simulation"
◗ Bug # 5218 fixed - Uicontrols of style 'text' are now
scrollable
◗ Bug # 5221 fixed - libhdf5 is defined with the GLIBC_2.7
as mandatory
◗ Bug # 5235 fixed - Error message added when
launching Scicos
◗ Bug # 5267 fixed - Scilab exited when closing Xcos
setup window using the upper right cross
◗ Bug # 5281 fixed - The menu "View->"Palette Browser"
is correctly checked at Xcos start
◗ Bug # 5299 fixed - When saving a Xcos diagram, when
the selected file was already existing and did not contain
the .xcos extension (~/foo), the 'Replace file' dialog
appeared but did not overwrite the file
◗ Bug # 5301 fixed - When a superblock was created with
the region to superblock, selected internal links were not
included into the superblocks but were also not considered
as IN_f OUT_F
◗ Bug # 5305 fixed - Display of filenames used by Xcos
was wrong (under Windows)
◗ Bug # 5310 fixed - Closing a Xcos diagram closed all of
Xcos
◗ Bug # 5312 fixed - 'Compile' information was not
displayed
◗ Bug # 5313 fixed - Clicking repeatedly and quickly on a
block in a diagram made Scilab quit
◗ Bug # 5327 fixed - When indenting a block, the selection
area was shifted one line down with respect to the
previously selected one
◗ Bug # 5328 fixed - The RegionToSuperblock action
produced a poorly rendered diagram
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◗ Bug # 5336 fixed - Xcos palette tabs now load much
faster and use less memory
◗ Bug # 5343 fixed - The DLSS_f block was transparent
when dropped in the working area
◗ Bug # 5344 fixed - Status of a modified file did not
change on 'Save As'
◗ Bug # 5347 fixed - The 'Region to superblock' action
crashed Xcos 
◗ Bug # 5348 fixed - Opening a Superblock crashed Xcos
◗ Bug # 5349 fixed - The file predator.cos could not be
opened
◗ Bug # 5351 fixed - Remove ports on a block remove the
connected links 
◗ Bug # 5353 fixed - Bad French localization for "set
context"
◗ Bug # 5383 fixed - FROMWSB from workspace block
was not working 
◗ Bug # 5388 fixed - Editor dialogs was not centered on
editor main window
◗ Bug # 5389 fixed - If there was no C compiler detected
on Windows, Xcos tried to call dynamic link functions
◗ Bug # 5395 fixed - The Xcos block AFFICH_m did not
bother with the max number of digits
◗ Bug # 5397 fixed - If there was a unconnected block in a
superblock, the simulation did not start and the
"Simulate/start" menu remained disabled
◗ Bug # 5403 fixed - A graphic window is created only
when needed
◗ Bug # 5404 fixed - Open & close Editor created a java
exception
◗ Bug # 5405 fixed - The whole diagram is now updated
when a superblock is modified
◗ Bug # 5407 fixed - It was impossible to use the arrow
keys to move a block
◗ Bug # 5410 fixed - Html4.0 specific symbols were used
◗ Bug # 5412 fixed - Context modifications were not saved
for Superblocks
◗ Bug # 5416 fixed - Blocks modifications were not saved
for Superblocks
◗ Bug # 5417 fixed - AUTOMAT and PDE blocks were in
demo blocks
◗ Bug # 5418 fixed - DEBUG_SCICOS block was not in
the palette
◗ Bug # 5419 fixed - French translation issues
◗ Bug # 5422 fixed - A file was not a unique diagram
instance (opened twice)
◗ Bug # 5423 fixed - French translation issues
◗ Bug # 5424 fixed - French translation issues
◗ Bug # 5426 fixed - The icon of modelica blocks Resistor
Inductor was not rotating while the block was
◗ Bug # 5428 fixed - Connecting Implicit I/O port to Link
was not allowed
◗ Bug # 5437 fixed - Show error message during Xcos
simulation initialization
◗ Bug # 5440 fixed - OUT* blocks were not in the sinks
palette 
◗ Bug # 5441 fixed - Xcos files (XML files) contained their
own paths
◗ Bug # 5442 fixed - Undo a Mirror Action did not work as
expected

◗ Bug # 5444 fixed - When the Xcos compiler failed to find
the size of the data on some links it asked user for it into a
bad window
◗ Bug # 5445 fixed - The modified state was not updated
on undo/redo
◗ Bug # 5449 fixed - The palette tab position was modified
even if invisible
◗ Bug # 5450 fixed - The Signal Builder demos did not
work (xcos/demos/Signal_Builder.xcos does not exist)
◗ Bug # 5459 fixed - Editor "block" Scilab with example
◗ Bug # 5464 fixed - Actions were not disabled on file
loading
◗ Bug # 5474 fixed - The demo Standard demos --> Scilab
block was not working
◗ Bug # 5475 fixed - drag & drop .xcos file on console did
not open Xcos diagram
◗ Bug # 5480 fixed - When creating a Superblock, input
and output links were removed and input and output ports
were not created
◗ Bug # 5528 fixed - ENDBLK and ENC_c blocks (Sinks
palette) did not have icons
◗ Bug # 5529 fixed - The parent diagram was not updated
when performing undo/redo on a SuperBlockDiagram
◗ Bug # 5530 fixed - IN_f, OUT_f and similars blocks did
not accept expression as parameter
◗ Bug # 5531 fixed - Setup values were not strongly typed
(use of spinner)
◗ Bug # 5533 fixed - SetupAction did not valid inputs
◗ Bug # 5592 fixed - The Xcos startup operations were
performed on the Scilab execution thread
◗ Bug # 5594 fixed - The links did not move on arrow key
typing
◗ Bug # 5598 fixed - The CLKOUT_f block was not an
EventOutBlock
◗ Bug # 5634 fixed - The export functionnality did not work

TREE FUNCTIONS
Rename tree functions:

◗ insertNode      => uiInsertNode
◗ getParentNode   => uiGetParentNode
◗ getNodePosition => uiGetNodePosition
◗ getChildrenNode => uiGetChildrenNode
◗ findNode        => uiFindNode
◗ equalsTree      => uiEqualsTree
◗ dumpTree        => uiDumpTree
◗ deleteNode      => uiDeleteNode
◗ createTree      => uiCreateTree
◗ createNode      => uiCreateNode
◗ concatTree      => uiConcatTree
◗ displaytree     => uiDisplayTree

◗ Bug # 5170 fixed - displaytree() name was not
homogeneous with other tree functions
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BUG FIXES
◗ Bug # 2588 fixed - Calling a function with no input
argument contained in an mlist generated an error
◗ Bug # 3200 fixed - The add_help_chapter function
returned a boolean
◗ Bug # 3478 fixed - file function returned a wrong error
message when file did not exist
◗ Bug # 3593 fixed - Macros to read and write csv file
format updated
◗ Bug # 3675 fixed - Issues when saving/loading gui
(uicontrols,figure...) fixed
◗ Bug # 3849 fixed - Path selected for graphics export is
now memorized and used as default for next export file
selection
◗ Bug # 4401 fixed - isnum returned wrong values
◗ Bug # 4435 fixed - bench_run is now documented
◗ Bug # 4565 fixed - getvalue macro was defined twice
◗ Bug # 4670 fixed - ilib_build examples updated with
api_scilab
◗ Bug # 4767 fixed - Typo in minreal was causing errors in
some cases
◗ Bug # 4844 fixed - The help page for the deletefile
function did not specify what was the meaning of the
output variable
◗ Bug # 5025 fixed - The Tabbed palette manager became
a Tree palette manager
◗ Bug # 5037 fixed - The link style menu did not have
mnemonics
◗ Bug # 5077 fixed - Demo neldermead/output Command
failed under Windows (Release)
◗ Bug # 5106 fixed - mopen help page did not contain any
example
◗ Bug # 5107 fixed - mgetstr help page did not contain
any example
◗ Bug # 5163 fixed - Incorrectly resized text after having
performed magnification+demagnification
◗ Bug # 5190 fixed - Context menus are now available
under MacOS
◗ Bug # 5195 fixed - "get" crashed with "Lycee" module
◗ Bug # 5200 fixed - Adding a code generation error
message when not applicable
◗ Bug # 5211 fixed - A non reg test was failing with the
binary of Scilab
◗ Bug # 5213 fixed - ATOMS GUI: Module's author(s) was
not displayed
◗ Bug # 5214 fixed - ATOMS GUI: The download size was
not displayed
◗ Bug # 5233 fixed - The Windows installer bugged in
some cases
◗ Bug # 5237 fixed - ATOMS: The load of an ATOMS
module could produce an error. The error is now catched.
◗ Bug # 5249 fixed - Using the help or apropos functions,
some words (stop word) were not taken into account
during the search
◗ Bug # 5251 fixed - getversion help page updated
◗ Bug # 5258 fixed - diary help page had some erroneous
timestamp prefix formats
◗ Bug # 5259 fixed - root_properties help page displayed
mis-encoded characters
◗ Bug # 5263 fixed - diary returned incorrect path for
automatically numbered filenames

◗ Bug # 5266 fixed - Modelica demos made available in
MacOS binary version
◗ Bug # 5271 fixed - ATOMS GUI: Frames title was not
emphasized
◗ Bug # 5283 fixed - Intel Fortran 11 compiler did not
require to import some settings in Visual Studio
◗ Bug # 5284 fixed - Function "legend" drew line
segments in its box in a reverse order
◗ Bug # 5286 fixed - Calling the 'lib' function with the
wrong path made Scilab hung
◗ Bug # 5292 fixed - There was a conflict between bool
and Scilab header mex.h (with Visual Studio and mex
files)
◗ Bug # 5293 fixed - Undocumented features with function
string(x)
◗ Bug # 5294 fixed - In mex.h, we had a bad type
declaration
◗ Bug # 5295 fixed - configure: LibGL.so included at link
time when linking with libjogl.so
◗ Bug # 5298 fixed - Obsolete Makefile in the mexlib
module
◗ Bug # 5307 fixed - In Neldermead, inconsistent shape
for the input argument x of the cost function
◗ Bug # 5325 fixed - Wrong default path on FileChooser
◗ Bug # 5326 fixed - graphic_export module was not
loaded dynamically
◗ Bug # 5330 fixed - "help str1 str2" returned an error
◗ Bug # 5331 fixed - There was no example in the help
page of matfile_* loadmatfile or savematfile
◗ Bug # 5339 fixed - Some macros had multiple definitions
◗ Bug # 5340 fixed - There was no example in the help of
arma 
◗ Bug # 5355 fixed - There was no automatic indentation
in the editor when commands such as "try" or "catch" were
entered
◗ Bug # 5359 fixed - ATOMS: Path of the non-existing
loader file was not well displayed at Scilab startup
◗ Bug # 5360 fixed - "sciargs" documentation help page
updated
◗ Bug # 5367 fixed - Incorrect %nan multiplication with
vectors on 64-bit Vista
◗ Bug # 5368 fixed - input() behaved weird on carriage
return response to prompt on 64-bit
◗ Bug # 5373 fixed - isalphanum() did not support non
ascii chars
◗ Bug # 5375 fixed - isdigit() did not support non ascii
chars
◗ Bug # 5376 fixed - tool_skeleton.iss had not been
updated
◗ Bug # 5384 fixed - get_absolute_file_path was case
sensitive with filename on Windows
◗ Bug # 5391 fixed - Bad warning/error messages in
ATOMS
◗ Bug # 5402 fixed - Update status bar contents after
saving canceled
◗ Bug # 5413 fixed - help_from_sci: An error was triggered
when < or > where used in the comments
◗ Bug # 5431 fixed - When network is unreachable,
ATOMS now displays an explicit warning and return softly
◗ Bug # 5433 fixed - LCC-Win32 did not work with Scicos
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◗ Bug # 5452 fixed - legend reversed the order of plotted
curves
◗ Bug # 5453 fixed - ATOMS: Sizes were displayed with
French units
◗ Bug # 5456 fixed - TCL_UpVar(source,alias) returns %T
even if the TCL variable source did not exist and then
aliasing had not been performed
◗ Bug # 5457 fixed - Scilab could not start with Korean
Win XP
◗ Bug # 5460 fixed - Added menus 'Close All' and 'Close
all but this' in editor
◗ Bug # 5461 fixed - The savematfile did not work when a
format argument was given
◗ Bug # 5462 fixed - savematfile() did not save correctly
sparse matrices
◗ Bug # 5469 fixed - Force origin presence on axes with
location property set to 'origin'
◗ Bug # 5470 fixed - The addcolor function help page did
not contain example
◗ Bug # 5484 fixed - LCC-Win32 failed to generate
makefile.lcc with this example
◗ Bug # 5487 fixed - help_from_sci was taking the first line
of code as author when no empty line was provided
◗ Bug # 5488 fixed - When the documentation was
extracted from a .sci file using help_from_sci function, the
docbook refsynopsisdiv section was not correct
◗ Bug # 5489 fixed - When the documentation was
extracted from a .sci file using help_from_sci function, the
docbook Author refsection section was not correct
◗ Bug # 5494 fixed - On Windows 2000, stacksize with the
argument 'max' set stack to minimum size if it failed
◗ Bug # 5499 fixed - tbx_build_loader() automatically
added a test about version in the loader.sce even if the
module has been 100% written in Scilab code
◗ Bug # 5505 fixed - getdebuginfo() output in French was
partially translated, with few errors
◗ Bug # 5506 fixed - There were some memory leak with
getMatrixOfWideString
◗ Bug # 5507 fixed - whereis(bin2dec) returned an error
◗ Bug # 5511 fixed - printf_conversion help page was not
clear
◗ Bug # 5513 fixed - input("message") did not restore the
original prompt after the input job was done
◗ Bug # 5532 fixed - added a "Save All" menu to save all
modified files by editor
◗ Bug # 5546 fixed - Initialization trouble of the variable
"compilerpath"
◗ Bug # 5577 fixed - help_skeleton macros encoded the
generated xml file in ISO-8859-1 and not in UTF-8
◗ Bug # 5585 fixed - sysdiag(): Both examples were
duplicated
◗ Bug # 5586 fixed - getscilabkeyworgs was broken
◗ Bug # 5604 fixed - Fminsearch: optimsimplex_new did
not check for consistency of x0 and len for "axes" simplex
◗ Bug # 5607 fixed - 'mtlb_mode' did not work on
Windows
◗ Bug # 5615 fixed - xls_open failed if there was a trailing
space after the file extension
◗ Bug # 5619 fixed - bitset() could not set hypermatrix bits
◗ Bug # 5620 fixed - dec2bin() could not convert
hypermatrices
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